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Basics

About the 360 Round
The 360 Round camera records high quality 360-degree videos and broadcasts videos in real 
time. You can record high-quality 360-degree 2D or 3D 4K videos with 17 cameras, and 3D 
sound with 6 internal microphones.

Save high-quality 4K videos after stitching, or broadcast high-quality 4K videos in real time.

Enjoy virtual reality on VR devices recorded on the 360 Round.
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Read me first
Please read this manual before using the 360 Round to ensure safe and proper use.

• 	Images may differ in appearance from the actual product. Content is subject to change 
without prior notice.

• 	Before using the 360 Round make sure they are compatible with your camera.

• 	This product includes certain free/open source software. To see the instructions for 
viewing the open source license, go to the Samsung website opensource.samsung.com.

Maintaining water and dust resistance
Your camera supports water- and dust-resistance. Follow these tips carefully to maintain the 
water- and dust-resistance of your camera. Failure to do so may result in damage to your 
camera.

• 	To use the waterproof feature, attach the power adapter and LAN cable to the waterproof 
adapter. Close the cover of the external microphone jack, memory card slot, and 
multipurpose jack, and then lock the cover switches.

• 	If the 360 Round is not dried thoroughly, the sound may not record correctly. Dry the 360 
round thoroughly before recording video.

• 	When you attach an external microphone, the waterproof feature may not be supported.

• 	If you are using the camera while it is connected to an SSD and external battery, the 
waterproof feature is not available.

• 	Do not expose the camera to a jet of water, rainwater, etc for more than 3 minutes.

• 	Do not immerse the camera in fresh water deeper than 5 ft or keep it submerged for 
more than 30 minutes. If you immerse the camera in any liquid other than fresh water, 
such as salt water, ionized water, or alcoholic beverage, liquid will enter the camera faster.

• 	Do not expose the camera to water moving with force, such as running water from taps, 
ocean waves, or waterfalls.

• 	If the camera is exposed to clean water, dry it thoroughly with a clean, soft cloth. If 
the camera is exposed to other liquids, such as salt water, ionized water, or alcoholic 
beverage, rinse it with clean water and dry it thoroughly with a clean, soft cloth. If you do 
not follow these instructions, the camera’s performance and appearance may be affected.

http://opensource.samsung.com
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• 	If the camera is dropped or impacted, the water-and dustresistant features of the 
camera may be damaged.

• 	The power adapter has no waterproof feature.

• 	Your camera has been tested in a controlled environment and certified to be water- 
and dust-resistant in specific situations (meets requirements of classification IP65 as 
described by the international standard IEC 60529-Degrees of Protection provided by 
Enclosures [IP Code]; test conditions: Water jet nozzle, flow rate (12 L/ min), at least 3 
minutes). Despite this classification, it is still possible for your camera to be damaged 
in certain situations.

Instructional icons

Warning: situations that could cause injury to yourself or others

Caution: situations that could cause damage to your 360 Round or other equipment

Notice: notes, usage tips, or additional information
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Package contents
Check the products inside the hard case.

• 	360 Round

• 	Power adapter

• 	Waterproof adapter (2 included)

• 	Quick start guide

• 	The items supplied with the 360 Round and any available accessories may vary 
depending on the region or service provider.

• 	The supplied items are designed only for this 360 Round and may not be 
compatible with other devices.

• 	Appearances and specifications are subject to change without prior notice.

• 	You can purchase additional accessories from the Samsung website. Make sure 
they are compatible with the 360 Round before purchase.

• 	Use only Samsung-approved accessories. Using unapproved accessories may cause 
the performance problems and malfunctions that are not covered by the warranty.

• 	Availability of all accessories is subject to change depending entirely on 
manufacturing companies. For more information about available accessories, refer 
to the Samsung website.

• 	Always keep the 360 Round inside the hard case when it is not in use. If the 
cameras are scratched or damaged, the video’s quality may be reduced.
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Required specification

Preparation material Required specification

Memory card

• 	UHS II U3 Read 150 MB/s

• 	Write speed 80 MB/s or more

• 	Maximum supported: Up to 512 GB

Tripod

• 	Connected screw: 0.4 inch

• 	Bearing weight: 2 lb

• 	Minimum height: 5 ft

LAN cable • 	Cat 6a, 0.2 inch in diameter and under 328 ft long

Computer (for 
stitching)

• 	Operating system: Windows 10 Professional or above, 64 bit

• 	CPU: Intel Core i7-6700 K or above

• 	Graphics card: NVIDIA: GTX 1080 1 each or more

• 	RAM: 16 GB DDR4 RAM 2 each or above

• 	Power: 850 W

Computer (for preview 
and Live stream)

• 	Operating system: Windows 10 Professional or above, 64 bit

• 	CPU: Intel Core i7-6950 X or above

• 	Graphics card: NVIDIA: GTX 1080 Ti 2 each or more

• 	RAM: 32 GB DDR4 RAM 2 each or above

• 	Power: 1,600 W

Power adapter
• 	Input: 100-240 VAC, 50-60 Hz

• 	Output: 19 VDC, 2.1 A

• 	Requirement except the power adapter are sold separately.

• 	The above requirements are the minimum required for using the 360 Round. If 
your computer does not meet the minimum specifications, some features may be 
restricted.
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Device layout

OK key

Direction key

OK

Record key

Status screen

Top camera

Side camera (16)

Microphone (6)

Camera status light 
(4)

When you use the 360 Round and record the video for a long time, wipe the lens 
periodically.
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Power key

LAN port

Status indicator light

External 
microphone jack

Memory card slot

Speaker

Tripod socket

Power adapter jack

Multipurpose jack 
(USB Type-C)

Keys

Key Function

Power • 	Turn the 360 Round on or off.

Record • 	Start or stop recording a video.

Up • 	Move to the above option.

Down • 	Move to the below option.

Left • 	Move to the previous step.

Right • 	Access the settings menu or move to the next step.

OK • 	Select an option.
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Indicator light and camera status light
You can check the recording status of the 360 Round through the camera status light, and 
check the current status through the indicator light.

Color Status

Indicator light flashes 
blue three times

• 	Power on

• 	Successfully formatting a memory card or resetting the 360 
Round

Indicator light flashes 
blue

• 	Transferring data

• 	Updating software

• 	Formatting a memory card
Indicator light flashes 
red three times

• 	Power off

Indicator light flashes 
red

• 	Error occured

• 	Overheating
Camera status light 
flashes red

• 	Recording videos
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Camera status screen
Access menus, such as camera modes and connection modes, and view the 360 Round’s 
status via messages and indicator icons on the camera status screen.

Camera status 
screen

Indicator icons
Indicator icons appear on the camera status screen. You can check the 360 Round’s status on 
the camera status screen.

Storage location

Date and time

Recording status

Recording mode

Frame rate

LAN cable connection 
status

Audio recording 
status
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Icon Meaning

Video saved to memory card

Video saved to SSD storage

Set to automatic recording mode (Aperture priority mode)

Set to manual recording mode (Manual mode)

 / Frame rate

Can not record audio

Timer set

Memory card full

No memory card

Memory card recognition error

LAN cable connected

Temperature abnormality

Moisture detected on multipurpose jack

Connected to a computer
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Memory card

Installing a memory card
A memory card must be inserted to record videos. Depending on the memory card 
manufacturer and type, some memory cards may not be compatible with your 360 Round.

• 	Some memory cards may not be fully compatible with the 360 Round. Using an 
incompatible card may damagethe 360 Round or the memory card, or corrupt the 
data stored in it.

• 	If you use a slow writing memory card, the recording of your video can be 
interrupted because the card cannot process data at the rate the video is being 
shot. Replace the card with a faster memory card.

• 	Use caution to insert the memory card right-side up.

• 	The 360 Round supports memory cards using the exFAT file structure. Refer to 
Required specification for required memory card specifications.

• 	Memory cards are sold separately. Before purchasing a memory card, be sure to 
check the specifications of the memory card and purchase a memory card that 
supports the required specifications or above.

• 	If you insert or remove a memory card while the 360 Round is turned on, the 
power automatically turns off. To use the 360 Round, turn it on again.

• 	Frequent writing and erasing of data shortens the lifespan of memory cards.

• 	When a memory card is not inserted, No media is displayed on the camera status 
screen.
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1	 Unlock the memory card slot switch to open the memory card slot cover.

2	 Insert the memory card into the memory card slot until it clicks into the place.

Be careful not to damage your fingernails when you insert the memory card.

3	 Close the memory card slot cover and lock the slot cover switch.
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Removing the memory card

1	 Unlock the memory card slot switch to open the memory card slot cover.

2	 Gently push the memory card in and pull out the removed memory card completely.

3	 Close the memory card slot cover and lock the slot cover switch.

Formatting the memory card
You can format the memory card on the 360 Round or computer.

Before formatting the memory card, remember to make backup copies of all 
important data stored in the memory card. The manufacturer’s warranty does not 
cover loss of data resulting from user actions.

On the 360 Round

1	 Press the Right key on the 360 Round to access the settings menu.

If the 360 Round is connected to the computer with a LAN cable, you can not enter 
the settings menu. Remove the LAN cable before formatting the memory card on the 
360 Round.

2	 Press the Down key until Manage files appears on the camera status screen and press 
the OK key.

3	 Select Format storage → OK and press the OK key.

When formatting is complete, the completion message appears on the camera status 
screen.

On the computer

Connect the 360 Round and your computer with a LAN cable before formatting the 
memory card on your computer.

1	 Launch the 360 Round program on your computer.

2	 Click Device tab → Manage files → Format → OK on the control panel.

The memory card will be formatted.
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Installing the 360 Round
Attach a tripod on the 360 Round and place it on a flat area. Connect the 360 Round to your 
computer via a LAN cable to control the 360 Round from your computer.

Installation tips
• 	Set up the 360 Round and tripod securely on a flat area so that they do not topple over.

• 	Keep a minimum distance of at least 5 ft between the 360 Round and the subject, 
otherwise the recorded video may appear to be unnatural.

• 	Install the 360 Round a minimum distance of at least 5 ft above ground, and at least 5 ft 
under a ceiling.

5 ft or more

5 ft or more

• 	If the 360 Round is tilted vertically or rotated while recording, the recorded video may 
appear to be unnatural.

• 	If you use the 360 Round in a dark location, the recommended ambient brightness 
should be at least 100 lx.
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• 	Move any objects you do not want to record from the 360 Round’s view.

• 	If you install the 360 Round outdoors, be sure to place the power adapter in a waterproof 
power box as it is not waterproof.

Caution when using an AC power terminal
Connect the power plug pin vertically into the center hole of the power terminal.

• 	If you do not connect the plug pin directly into the center hole, it will not be correctly 
connected. Reconnect the plug pin until it fits correctly into the center hole.

• 	Connect the power plug to the power terminal when the power indicator light 
(LED) flashes green. The power indicator light (LED) flashes green when it is correctly 
connected. If the power plug is connected incorrectly, the power indicator light (LED) will 
turn off. Disconnect the plug and check the power indicator light (LED) is on, and then 
reconnect.

Power indicator light (LED)

Center hole

Power plug (220 V) Power plug (110 V)
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Using as a stationary 360 Round

1	 Insert the tripod into the 360 Round’s tripod socket.

2	 Connect the LAN cable to the 360 Round’s LAN port and to the computer’s LAN port.

3	 Plug the power adapter into the 360 Round’s power adapter jack, and into an electric 
socket.

4	 Set up the tripod upright.

• 	The LAN cable and tripod are sold separately. Set up the tripod so it is not included 
in the frame when you are shooting a video.

• 	If the length of the LAN cable that connects the 360 Round and the computer is 
more than 328 ft, using an optic LAN converter is recommended.

• 	Avoid high-voltage electronics when installing the LAN cable.

Using as a portable 360 Round
Insert a UHS II SD card or connect an SSD, and connect the external battery to use the 360 
Round without connecting it to your computer and power adapter.

Connect the SSD to the multipurpose jack and connect the external battery to the power 
adapter jack. You can control the 360 Round using the 360 Round’s keys.

External battery

SSD

Use either a 12 V, 16 V or 19 V standard external battery of 2 A or more. The 360 Round 
may not work correctly if you use a non-standard external battery.
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Waterproof adapter

Body Washer

Rubber stopper Cap

Two rubber stoppers are provided with the 360 Round, the rubber stopper with the 
small hole is fitted to the power adapter jack, and the rubber with the large hole is 
fitted to the LAN cable. Use the appropriate rubber stopper. If you cannot distinguish 
the sizes, check the imprint under each rubber stopper.

Using the waterproof adapter
To use the waterproof feature, each waterproof adapter must be attached to the supplied 
power adapter and to the LAN cable (Cat 6a, 0.2 inch in diameter and under 100 m long, sold 
separately).

1	 Twist the cap of the waterproof adapter to remove the cap, washer and rubber stopper.
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2	 Attach the cap, washer, rubber stopper and body respectively to the connecting cable.

1
2

3

4

3	 Connect the cable to the 360 Round and align the white dot located on the bottom of 
the waterproof adapter’s body with the  in the port compartment on the 360 Round. 
Turn the waterproof adapter in the direction of the  to securely lock it to the 360 Round 
until it clicks.

1 2
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4	 Insert the rubber stopper and washer in order into the body and turn the cap to lock until 
it clicks.

1
2

• 	Lock the waterproof adapter securely in place. If there is a space between the 
rubber stoppers, the power adapter cable, and the LAN cable, the waterproof 
adapter may not work correctly.

• 	If the power adapter and the LAN cable are very thin or thick, or if you use non-
standard cables, the waterproof adapter may not work. Samsung recommends 
using a power adapter cable 0.1 inch in diameter and a LAN cable 0.2 inch in 
diameter.

• 	Be careful not to allow the power adapter to come into contact with water.

• 	Do not touch the 360 Round, power cable, plug and socket with the wet hands 
or other body parts. The 360 Round may be damaged or you may be affected by 
electricity.
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Turning the 360 Round on and off
Press and hold the Power key to turn on the 360 Round.

Indicator light flashes blue three times.

To turn off the 360 Round, press and hold the Power key again.

Indicator light flashes red three times.

• 	When the 360 Round is connected to your computer, you can turn the 360 Round 
on and off via the 360 Round program.

• 	You can set the power to turn off automatically when the 360 Round is not used for 
a certain period of time. The power off time can be selected from the Auto power 
off setting menu. Refer to System settings for more information.

• 	Follow all posted warnings and directions from authorised personnel in areas 
where the use of wireless devices is restricted, such as aeroplanes and hospitals.

Restarting the 360 Round
If your 360 Round is frozen and unresponsive, disconnect the power cable and reconnect it. 
Press and hold the Power key to restart it.
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Using the 360 Round

Learning more about 360 Round PC program
By using the 360 Round PC program, you can record videos or stream a live broadcast on your 
computer.

Use the 360 Round program to configure the 360 Round’s settings and records videos and 
start to broadcast videos in real time. You can also use the 360 Round Viewer to stitch or view 
stored videos.

The 360 Round screen recording 360-degree video
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The 360 Round Viewer screen viewing recorded 360-degree video

Installing and launching the 360 Round PC program

1	 Download the 360 Round PC program from www.samsung.com/business.

2	 Connect the camera to the computer with the LAN cable while the power adapter is 
connected.

3	 Press and hold the Power key to turn on the camera.

4	 Launch the 360 Round program on your computer.

The preview screen will appear.

http://www.samsung.com/business
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Recording videos

Introduction
You can record a 360-degree video in 2D or 3D format with 17 cameras. You can also record 
videos using the 360 Round solely, or connect it to a computer and record using various 
functions.

A memory card must be inserted into the 360 Round to record videos.

Camera etiquette
• 	Do not record videos of other people without their permission.

• 	Do not record videos where legally prohibited.

• 	Do not record videos in places where you may violate other people’s privacy.

Tips for getting the best shots
• 	Make sure that the lenses are clean and avoid touching the lenses while capturing videos.

• 	Installing the camera on a tripod is recommended to prevent the camera shaking.

• 	Do not disconnect the camera from the LAN cable while transferring files. The camera 
and data may be damaged.

• 	The 360 Round stops recording video or turns off automatically if the temperature rises 
above a certain level when it has been used for extended periods. In this case, turn it off 
and wait until it has sufficiently cooled.
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Recording videos using a computer
Use your computer as a viewfinder to record videos. Installing the 360 Round program on 
your computer makes it easier to record videos or start live broadcasts.

You can check and change video settings during a recording.

1	 Launch the 360 Round program on your computer.

The preview screen will appear.

Apply full screen.

Start or stop 
recording.

Select a camera 
to use.

Adjust the 
volume of 
recording audio.

Set the preview 
screen mode.

Rotate the 
screen.

Menu bar

Control panel

Start live 
broadcasting.

Recording 
information 

panel

Preview screen

2	 Click Device tab → Storage on the control panel and select a location to save videos.

You can select PC and save videos to your computer or select Camera and save videos to 
the camera’s memory card.

3	 Configure camera settings on the control panel of the program.
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4	 Click  next to  and select the recording mode.

• 	RAW SLS: You can record 3D videos in Source view mode and also record original 
videos that are not stitched.

• 	Stitched MP4: You can record 2D or 3D videos in Panoramic view mode.

A memory card must be inserted into the 360 Round to record videos.

5	 Click  next to  and select Settings.

6	 Click Stitched recording when the settings screen appears, enter information, and select 
OK.

7	 Click  to start recording a video.

The preview screen will appear on the computer and Recording will appear on the status 
screen of your camera. The camera indicator light will blink red.

8	 Press  to finish recording video.

Camera status light will turn off.

• 	The 360 Round stops recording video or turns off automatically if the temperature 
rises above a certain level when it has been used for extended periods. In this case, 
turn the 360 Round off and wait until it has cooled.

• 	The 360 Round has been developed for content production and can not be 
used for security such as CCTV. Do not use it outdoors for more than 12 hours 
continuously. Doing so may affect the life and performance of the 360 Round and 
may cause errors when recording videos.

• 	When connecting to a computer, the keys on the 360 Round will not work.

• 	To change the storage location, click Device tab → Storage → PC or Camera 
on the control panel. When the 360 Round is selected as the storage location, it 
changes to Panoramic view mode.

• 	A slight difference in time may occur between the actual subject movement and 
the subject movement on the preview screen.
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Checking the location of each camera
Before recording a video, check the location of the cameras on the top and side of the 360 
Round.

OK

216
1

0

15

8

14

7

13
6 12

5

11

4

10

3
9

• 	Top camera: The camera number 0.

• 	Left camera: The cameras number 1 to 8.

• 	Right camera: The cameras number 9 to 16.

Checking the location of each camera on the recording video screen

Check the location of the 17 cameras in the video you are recording on the 360 Round screen. 
The following screen shot was taken in Panoramic view mode using all 17 cameras.

13 14 15 16 9 10 11 12
0

5 6 7 8 1 2 3 4

2D mode

3D mode
0
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Changing the preview screen mode
You can change the preview screen mode to record 2D or 3D videos. When recording in 
Source view mode, you can record record original videos that are not stitched. In Panoramic 
view mode, you can record 2D and 3D videos.

Press  on View to change the preview screen mode.

• 	  Panoramic view: View the preview screen as a horizontally stretched screen.

• 	  Stretched view: View the recorded video as a big enlarged scene.

• 	  360˚ view: View the recorded video in spherical form.

• 	  Round view: View the recorded video as a rounded scene.

• 	  Source view: You can preview the screen recording by the cameras on each section. 
Select Top, Left 1, Left 2, Right 1 or Right 2 on the preview screen to check the recording 
videos from each section. Refer to Checking the location of each camera for detailed 
location of cameras on the right and left.

–– Top: Use the top camera numbered 0.

–– Left 1: Use the cameras on the left numbered 5 to 8.

–– Left 2: Use the cameras on the left numbered 1 to 4.

–– Right 1: Use the cameras on the right numbered 13 to 16.

–– Right 2: Use the cameras on the right numbered 9 to 12.
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Setting 2D or 3D mode
You can select which camera to use when you are recording video.

1	 Launch the 360 Round program on your computer.

2	 Click the L-R Camera button to select the camera to be used for recording. Refer to 
Checking the location of each camera for the detailed location of cameras on the right 
and left side of the 360 Round.

• 	On Panoramic view, Stretched view, 360˚ view or Round view mode:
––  : You can record 2D video using the 8 cameras on the right side, and the 
camera on the top of the 360 Round.

––  : You can record 2D video using the 8 cameras on the left side, and the 
camera on the top of the 360 Round.

––  : You can record 3D video with all of the 17 cameras on the 360 Round.

––  : All cameras are turned off and the preview screen is disabled.

• 	On Source view mode:
––  : You can record 3D video with all of the 17 cameras on the 360 Round.

––  : All cameras are turned off and the preview screen is disabled.

Rotating the preview screen
You can record and view videos by rotating the preview screen up and down in 180 degrees.

Click  to rotate the preview screen.

Adjusting the volume of recording audio
You can adjust the volume of the audio to be recorded.

Click  to adjust the volume.

If you set the volume excessively high when recording video in a high surrounding 
environment, the audio may be distorted. Launch the 360 Round program and click 
the Audio tab and set Mic. Level - Internal to Auto or Manual to turn down the 
volume.
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Recording videos with the 360 Round solely
You can record videos with the 360 Round without connecting it to your computer and 
power adapter. To record video with the 360 Round solely, you must connect a UHS II SD card 
or SSD and an external battery. Refer to Using as a portable 360 Round for more information.

1	 Press and hold the Power key to turn on the 360 Round.

2	 Press the Right key on the 360 Round and configure camera settings.

3	 Press the Record key to start recording video.

Recording appears on the status screen of the camera and recording will be start.

4	 To finish recording video, press and hold the Record key again.

The video will be saved in the UHS II SD card or SSD.

• 	The recorded videos are saved in the SSD or UHS II SD card. Even if the UHS II SD 
card is inserted, the SSD is recognized as the default storage location when the SSD 
is connected.

• 	When using an SSD, use an SSD that supports USB 3.1 Super Speed (5 Gbps).

• 	The 360 Round supports UHS II SD or SSD card using the exFAT file structure.

• 	If the SSD is connected to the 360 Round, you can not connect the 360 Round 
to the computer via a LAN cable. Remove the SSD from the 360 Round and then 
connect it to your computer via a LAN cable.
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Live broadcast
Invite your family and friends to watch videos you record with the 360 Round in real time.

• 	To use this feature, you must be connected to the Internet and sign in to your 
service account.

• 	Some features may vary depending on the service provider.

When you select Custom
When you select Custom, you can enter the setting values and adjust the broadcasting 
channel.

1	 Launch the 360 Round program on your computer.

2	 Click  next to  → Custom.

3	 Click .

4	 Click Live broadcasting when the settings screen appears, enter information, and click 
OK.

5	 Click .

The broadcast will begin.

6	 Click  to finish the broadcast.
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When you select Samsung VR

1	 Launch the 360 Round program on your computer.

2	 Click  next to  → Samsung VR.

3	 Click .

4	 Sign in to your Samsung VR account.

5	 Enter the title and details of the broadcast, and then set your broadcast to be public or 
private.

6	 Click Broadcast.

The broadcast will begin.

7	 Click  to finish the broadcast.
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Configuring camera settings

Configuring settings on your computer
Launch the 360 Round program on your computer. You can configure camera settings from 
the control panel on your computer.

Control panel

Video
• 	Mode: Set the recording mode.

–– Aperture priority: Set the shutter speed to be adjusted automatically according to the 
aperture value set by the user.

–– Manual: Set the shutter speed and aperture value to be set manually by the user.

• 	Quality: Set the quality of the video. The higher the quality, the larger the video’s size will 
be.

• 	Frame Rate: Set the number of frames to be recorded.

–– NTSC:29.97: Set to record 30 frames per second.

–– PAL:25.00: Set to record 25 frames per second.
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• 	Exposure Value: Adjust the exposure value. The exposure value is set automatically 
depending on the balance of brightness in the composition or the position of the main 
subject. Set the exposure value higher if the video is dark or set the exposure value lower 
if the video is bright.

• 	ISO: The ISO image sensor determines the sensitivity to light. The higher the ISO, the 
more sensitive the light is, so you can record bright videos in dark environments. 
However, as the ISO increases, the grain will be rougher and the noise will increase.

–– Limit: When Auto is selected in ISO, the maximum value of the ISO value is set and 
can not be adjusted beyond its maximum value.

• 	Shutter Speed: The shutter speed determines the exposure time that the camera (image 
sensor) accepts light.

• 	F number: Set the aperture size. The smaller the F value, the larger the diameter of the 
diaphragm and more light is allowed to pass through to change the brightness of the 
camera.

• 	Metering: Set the metering method. You can change the way light is measured on the 
recording screen.

–– Multi: Divide the entire recording screen, measure the light and apply the average 
value to the video.

–– Center: Measure the light in front of and around the camera and apply it to your 
video.

–– Spot: Only the light from the camera you select will be measured and applied to the 
video.

• 	Gamma: Set the gamma value that controls the tone and color of the video.

• 	Luminance Level: Set the brightness range of the video.
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• 	White Balance: By selecting the white balance according to the recording environment, 
you can display the color of the subject, which depends on the original color 
temperature, same as a person’s natural view.

–– Auto: The optimum light source is automatically set according to the light source 
conditions.

–– Daylight: This is the appropriate setting when recording on a clear day or outdoors, 
similar to what a person sees naturally.

–– Cloudy: This is the appropriate setting for cloudy days or shadows. It corrects the 
bluish color of a cloudy day.

–– Fluorescent_W: This is the appropriate setting when recording under a white 
fluorescent light.

–– Fluorescent_N: This is the appropriate setting when recording under a fluorescent 
light (significant white color).

–– Fluorescent_D: This is the appropriate setting when recording under daylight 
fluorescent light (slightly bluish color).

–– Tungsten: This is the appropriate setting when recording under a halogen lamp or 
incandescent lamp. Correct the incandescent yellow light.

–– K(Manual): You can also adjust the color temperature of the video.

• 	Sharpness: Set the clarity of the video.

• 	Night Mode: Block the infrared-absorbing filter and set the video to be recorded in black 
and white. You can record bright videos even in dark environments using infrared light.

• 	Individual Camera tune: Calibrate each camera separately. Select Tune cameras to start 
calibration.

–– Selected Camera: Select the camera to be calibrated on the preview screen.

–– RGB: You can adjust the RED, GREEN, and BLUE color value individually to raise or 
lower certain color tones on the preview screen.

–– Noise reduction: You can reduce the noise that can occur when recording with high 
sensitivity or when recording at high speed by increasing the ISO value.

–– Contrast: Calibrate the contrast of the video.

–– Sharpness: Set the clarity of the video.

–– Reset: You can select Reset Current camera to set the camera calibration values 
individually, or select Reset All camera to set them all as default.
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Audio
• 	Source: Select a device that will record audio.

• 	Voice: Turn on or off the audio to be recorded in the video.

• 	Mic. Level - Internal: Set the volume of the microphone.

–– Auto: Set the audio to be recorded at the optimal sound with the Samsung sound 
solution.

–– Manual: Set the audio to be recorded at the original sound without the Samsung 
sound solution.

• 	Sample rate: Set the sampling frequency of the recorded audio. The larger the sampling, 
the closer you can record to the original sound, but the size of the video may increase.

• 	Audio monitoring: You can check and set the audio status of the internal or external 
microphone.

Device
• 	Camera name: You can check or change the name of the 360 Round.

• 	Power: You can turn the 360 Round on and off or reboot it. All values will be reset as 
default when you reboot.

–– Device Mac: Set the Mac address of the 360 Round.

• 	Manage files: Manage and delete recorded videos. You can also format the memory card.

• 	Set Timer: Set the timer.

• 	Storage: Set the location to save the video to either the PC or the Camera.

• 	Info: Briefly check the information of the recording environment.
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Configuring settings on the 360 Round
You can change the recording environment or set the operating environment of the 360 
Round from the setup menu.

If the 360 Round is connected to a computer via a LAN cable, you can not enter the 
settings menu. Remove the LAN cable before entering the settings menu on the 360 
Round.

1	 Press the Right key on the 360 Round to access the settings menu.

2	 Press the Up key or Down key to access the settings menu you want.

3	 Press the OK key or Right key and select the settings menu.

Press the Left Key to cancel the settings or move to the previous step.

Video
• 	Mode: Set the recording mode.

–– Aperture priority: Set the shutter speed to be adjusted automatically according to the 
aperture value set by the user.

–– Manual: Set the shutter speed and aperture value to be set manually by the user.

• 	Quality: Set the quality of the video. The higher the quality, the larger the video’s size will 
be.

• 	Frame rate: Set the number of frames to be recorded.

–– NTSC:29.97: Set to record 30 frames per second.

–– PAL:25.00: Set to record 25 frames per second.

• 	EV: Adjust the exposure value. The exposure value is set automatically depending on 
the balance of brightness in the composition or the position of the main subject. Set the 
exposure value higher if the video is dark or set the exposure value lower if the video is 
bright.
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• 	ISO: The ISO image sensor determines the sensitivity to light. The higher the ISO, the 
more sensitive the light is, so you can record bright videos in dark environments. 
However, as the ISO increases, the grain will be rougher and the noise will increase.

–– ISO Limit: When Auto is selected in ISO, the maximum value of the ISO value is set 
and can not be adjusted beyond its maximum value.

• 	Shutter speed: The shutter speed determines the exposure time that the camera (image 
sensor) accepts light.

• 	F number: Set the aperture size. The smaller the F value, the larger the diameter of the 
diaphragm and more light is allowed to pass through to change the brightness of the 
camera.

• 	Metering: Set the metering method. You can change the way light is measured on the 
recording screen.

–– Multi: Divide the entire recording screen, measure the light and apply the average 
value to the video.

–– Center: Measure the light in front of and around the camera and apply it to your 
video.

–– Spot: Only the light from the camera you select will be measured and applied to the 
video.

• 	Gamma: Set the gamma value that controls the tone and color of the video.

• 	Luminance: Set the brightness range of the video.
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• 	WB: By selecting the white balance according to the recording environment, you can 
display the color of the subject, which depends on the original color temperature, same 
as a person’s natural view.

–– Auto: The optimum light source is automatically set according to the light source 
conditions.

–– Daylight: This is the appropriate setting when recording on a clear day or outdoors, 
similar to what a person sees naturally.

–– Cloudy: This is the appropriate setting for cloudy days or shadows. It corrects the 
bluish color of a cloudy day.

–– Fluorescent W: This is the appropriate setting when recording under a white 
fluorescent light.

–– Fluorescent N: This is the appropriate setting when recording under a fluorescent 
light (significant white color).

–– Fluorescent D: This is the appropriate setting when recording under daylight 
fluorescent light (slightly bluish color).

–– Tungsten: This is the appropriate setting when recording under a halogen lamp or 
incandescent lamp. Correct the incandescent yellow light.

–– Manual: You can also adjust the color temperature of the video.

• 	Sharpness: Set the clarity of the video.

• 	Night mode: Block the infrared-absorbing filter and set the video to be recorded in black 
and white. You can record bright videos even in dark environments using infrared light.

• 	AE-L: Reset the fixed exposure value in use.

Audio
• 	Voice: Turn on or off the audio to be recorded in the video.

• 	Source: Select a device that will record audio.

• 	Int. Mic level: Set the volume of the microphone.

• 	Sample rate: Set the sampling frequency of the recorded audio. The larger the sampling, 
the closer you can record to the original sound, but the size of the video may increase.
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Manage files
• 	Storage: Select a storage location to save the video.

• 	Delete files: Delete recorded videos.

–– Delete last file: Delete the last recorded movie.

–– Delete all: Delete all recorded videos.

• 	Format storage: All videos stored in the 360 Round or in the SSD or memory card will be 
deleted.

System settings
• 	Screen timeout: Set the time to turn off the screen automatically when the 360 Round is 

not in use.

• 	Set timer: Set the timer.

• 	Auto power off: Set auto power off.

• 	Beep Sound: Adjust the volume of the effect sound of the 360 Round.

• 	LED: Turn the indicator light on and off.

• 	Reset settings: Initialize the settings of the 360 Round.

• 	Date and time: Manually set the time and date displayed on the camera status screen or 
change the displaying format.

• 	Language: Select the language you want to use.

• 	About device: Check information such as the 360 Round’s name or firmware version, or 
update software.

• 	System check: Check the current status of the 360 Round or the memory card inserted in 
the 360 Round.
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Checking the video recording options

On the computer

Recording information panel

You can check the video recording options set on the control panel of the 360 Round 
program on the information panel. The setting values of the information panel are changed 
to what you set on the control panel.

On the 360 Round
You can check the video recording options set in the settings menu on the camera status 
screen. The indicator icons on the camera status screen are changed to what you set on the 
settings menu. Refer to Camera status screen for more information.

Stitching videos
You can make a 360-degree video by stitching recorded videos together.

1	 Launch the 360 Round Viewer program on your computer.

2	 Import an SLS file and click Export on the Library panel.

3	 Select a file to stitch from the file list.

To change the storage location of the file, click Change folder and select a folder to 
export videos.

4	 Click Export as single stitched video file or Export as multiple video file → Export.

The edge parts of each 17 camera’s recording will be deleted after stitching so that 
they will not affect the finished video’s quality.
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Viewing videos

Viewing videos recorded with the computer
You can view your recorded videos on your computer.

1	 Launch the 360 Round Viewer program on your computer.

2	 Click Import on the Library panel.

3	 Select a video to view and click Open.

The file will be added to the Library panel.

4	 Select the desire file or drag the file to the preview screen on the Library panel.

The video will be played.

Alternatively, click  on the Output Folder panel, and click the storage location, and 
then select a video from the videos list.

Changing the viewing mode
You can change the viewing mode while playing a video.

• 	  Panoramic view: View the recorded video as a horizontally stretched scene.

• 	  Stretched view: View the recorded video as an enlarged scene.

• 	  360˚ view: View the recorded video in spherical form.

• 	  Round view: View the recorded video as a rounded scene.

• 	  Three screen view: Split the screen to view the video with the right, left, and top 
camera respectively.

• 	In the Stretched view, Round view, and 360° view modes, you can view videos 
from different angles by dragging across the screen in any direction. To reset the 
angle to the default setting, tap .

• 	Only the Panoramic view mode is supported for videos recorded in 3D.
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Rotating the screen
You can view videos by rotating the screen up and down in 180 degrees.

Click  to rotate the screen.

Adjusting the volume of the recorded audio
You can adjust the volume of the recorded audio.

Click  to adjust the volume.

Viewing videos recorded solely by the 360 Round
Remove the UHS II SD card or SSD inserted in the 360 Round to check the recorded video. 
Refer to the user manual of each external storage device for more information.

Deleting videos

On the computer

1	 Launch the 360 Round program on your computer.

2	 Click Device → Manage files → Browse Camera storage on the control panel.

3	 Select the video to delete and click Delete.

To delete all videos, click Select all → Delete.

On the 360 Round

1	 Press the Right key on the 360 Round to access the settings menu.

2	 Select Manage files → Delete files.

To delete last recorded video, select Delete last files.

To delete all videos, select Delete all.
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Updating the software
The 360 Round and the 360 Round program can be updated to the latest software.

You can update the software of 360 Round and 360 Round program only if the 
computer is connected to a wireless or wired network.

Updating the 360 Round

On the computer

Connect the 360 Round to your computer via a LAN cable before updating.

1	 Connect the camera to the computer with the LAN cable while the power adapter is 
connected.

2	 Press and hold the Power key to turn on the 360 Round.

3	 Launch the 360 Round program on your computer.

4	 Click Help → Check for updates → Camera software → OK on the menu bar.

On the 360 Round
You can update the firmware directly from the 360 Round.

• 	If the 360 Round is connected to your computer via a LAN cable, you can not enter 
the settings menu. Remove the LAN cable before updating.

• 	Insert the SD card before updating. The firmware will be stored separately on the 
SD card.

1	 Connect the camera to the computer via a LAN cable while the power adapter is 
connected.

2	 Press and hold the Power key to turn on the 360 Round.
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3	 Press the Right key on the 360 Round to access the settings menu.

4	 Select System settings → About device → Software Update → OK.

Be careful not to turn off or disconnect the 360 Round from the power adapter cable 
during an update.

Updating the program

Updating the 360 Round program

1	 Launch the 360 Round program on your computer.

2	 Click Help → Check for updates → 360 Round software → OK on the menu bar.

Updating the 360 Round Viewer program

1	 Launch the 360 Round Viewer program on your computer.

2	 Click Help → Check for updates → OK on the menu bar.
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Appendix

Managing the 360 Round

Cleaning the camera
Use a brush to remove dust from the camera and status screen, and wipe with a soft cloth. For 
persistent dust, lightly wipe the lens with a little cleaning fluid on the lens cleaning paper and 
wipe the exterior with a soft cloth.

When using the 360 Round, fine dust may enter the camera and it may appear on the 
recorded videos depending on the recording environment. This is not a defect of the 360 
Round, but rather caused by fine dust entering the lens. Use a blower to clean the dust.

Using and storing the 360 Round
Do not store or use the 360 Round in the following situations:

• 	Extremely high or low temperature

• 	Where humidity is high or humidity changes rapidly

• 	Where there is direct sunlight or airtightness (such as in a closed car in summer)

• 	Where there is a strong vibration or a strong magnetic field (by motor, transformer, 
magnet)

• 	Where there is a lot of sand or dust

• 	Where there is a fire or volatile material

• 	Where there are mothballs such as naphthalene
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Using the 360 Round at the beach or near water
Please note the following when using the 360 Round near the beach or water.

• 	Be careful not to let water or sand get into the 360 Round. This may cause a malfunction.

• 	The 360 Round is not waterproof when the cover is open. Do not insert an adapter or 
memory card with wet hands.

• 	Do not touch the 360 Round, power cable, plug and socket with wet hands or another 
body part. The 360 Round may be damaged or you may be affected by electricity.

Dealing with dew
Moving from a cold place to a warm place in a short period of time may cause water droplets 
to appear inside of the 360 Round or on the lens. Turn off the power and wait for about one 
hour before using the 360 Round. If water droplets form on the memory card, remove the 
memory card and dry it completely before using it.

Troubleshooting
Before contacting a Samsung Service Center, please attempt the following solutions. Some 
situations may not apply to your 360 Round.

Your 360 Round does not turn on
Make sure the power adapter cable is connected properly to your 360 Round. If you use the 
360 Round as a portable, make sure that the external battery is connected properly.

The 360 Round does not connected to the computer properly or it is 
disconnected.
• 	Make sure that the 360 Round and your computer are properly connected to the LAN 

cable.

• 	Check your 360 Round is turned on.

• 	Make sure the specifications of the computer meets the recommended specifications of 
computer.
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The time on the 360 Round has been reset
The time will be reset when you update the 360 Round.

Your 360 Round is hot to the touch
When using the 360 Round for an extended period, the 360 Round and its battery may heat 
up. If the temperature rises above a certain level, the 360 Round will stop recording and turn 
off automatically to prevent damage. If the 360 Round is turned off due to overheating, wait 
for it to cool down before resuming use.

The memory card icon appears on the camera status screen
• 	Ensure that a memory card is inserted.

• 	Ensure that your memory card is not damaged.

Data stored in the 360 Round has been lost
Always make backup copies of all important data stored in the Gear 360. Otherwise, you 
cannot restore data if it is corrupted or lost. Samsung is not responsible for the loss of data 
stored in the Gear 360.

A small gap appears around the outside of the 360 Round case
• 	This gap is a necessary manufacturing feature and some minor rocking or vibration of 

parts may occur.

• 	Over time, friction between parts may cause this gap to expand slightly.

The lens is dirty
Wipe the lens in a circular motion with a clean, soft cloth.
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Safety information

Follow the warning information provided below to prevent incidents 
such as fire or explosion
• 	Do not expose thecamera to physical impact or damage.

• 	Use only manufacturer-approved accessories and supplies.

• 	Prevent the power adapter jack, LAN port, etc. from contacting conductive elements, 
such as metal or liquids.

• 	If any part of the camera is cracked or broken, stop using the camera immediately.

Follow the warnings below to prevent injury to people or damage to 
thecamera
• 	Do not allow children or animals to chew or suck the camera.

• 	The camera can be used in locations with an ambient temperature of 0 °C to 35 °C. You 
can store the camera at an ambient temperature of -20 °C to 50 °C. Using or storing the 
camera outside of the recommended temperature ranges may damage the camera.

• 	Do not use your camera in a hot environment or near fire.

• 	Comply with all safety warnings and regulations regarding mobile device usage while 
operating a vehicle.

• 	Use only the power adapter supplied with the camera. Using an unapproved adapter 
may cause an electric shock.

• 	When connecting the camera to the tripod or fixing it to a high position, make sure to 
tighten the connecting part. If the connecting part become loose and falls down, the 
camera may be damaged or it may result in personal injury.

• 	Do not use your camera outdoor during a thunderstorm.
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